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Set up VR in Unity



https://static.acer.com/up/Resource/Acer/Wearable/WMR/Design/Hotspot/20170922/Inside-Out%20Tracking.jpg

Tracking

Inside-Out Tracking Outside-In Tracking



https://forums.tomsguide.com/fag/how-to-set-up-your-vive-base-stations-for-cabled-sync.111306/ddd

Outside-In; HTC Vive Pro




https://hitmotion.games/oculus-quest-mixed-reality/

Inside-Out: Oculus Quest




setup Oculus Quest HMDs



Quest

 Room or stationary boundary

« Enable hand tracking

« Upload .apk
» Enable developer mode on your Quest

» Using SideQuest



https://support.oculus.com/guardian/
https://uploadvr.com/how-to-enable-quest-hand-tracking/
https://learn.adafruit.com/sideloading-on-oculus-quest/enable-developer-mode
https://uploadvr.com/sideloading-quest-how-to/

start with two
tutorials in HMD

= Enable Uink (Reta)
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setup Oculus hand tracking



setup Unity



We will need to set up a unity environment to build
android applications on Quest.

A reference: https://grendelgames.com/setting-up-your-oculus-within-unity-to-develop-vr-applications/



https://grendelgames.com/setting-up-your-oculus-within-unity-to-develop-vr-applications/

You can either create a new project or
use your old roll-a-ball



Build platform for Quest

Build Settings

* File > Build settings > select Android

« Switch Platform

Add Open Scenes

() Pc, Mac & Linux Standalone Q)

Don't override
32-bit

‘ Universal Windows Platform

=
N

o
4

itch And Run

Patch

4

Player Settings... Switch Platform Build And Run




VR APls in Unity

&) oculus

Oculus Integration
link

« developing with the original
code from oculus

« the latest feature included
(e.g., hand tracking)

Unity XR Input
link

a wrapper so that you don't
need to touch oculus code
not always have the latest
feature


https://docs.unity3d.com/Manual/xr_input.html
https://assetstore.unity.com/packages/tools/integration/oculus-integration-82022

<t

Import Oculus Integration

1 2 3

ity Package n
Window Help
) unityAssetStore  Assetsv Toolsv Servicesv By Unityv Industries v
Next Window Ctrl+Tab € unity Asset Store i o Oculus Integration
Previous Window Ctrl+Shift+Tab
Q Search for assets
Layouts > Y v/ I Oculus
v v mAudioManager [NEW]
Asset Store Ctr|+9 Home > Tools > Integration > Oculus Integration Y v .AUdIO [NEW |
Package Manager Y v ImTestSounds [NEW ]
] You downloaded this item on Oct 5, 2020. 4 n metaI_sliding_door_close_01 .wam
Asset Management > : Please rate and review this asset. Your honest review and rating will help other users who are deciding M ﬂ metal_sliding_door_close_01a.wLi
§ whether they should get this asset. v i metal_sliding_door_open_01.wawiil
TextMeshPro . v J1 metal_sliding_door_open_01a.waiii
G | N v v ImScenes [NEW]
enera_ M Oculus Integration v v ImScripts —
Rendering > a1 400 v |# TestScript.cs [NEW]
Oculus Y % Y vr 409 Reviews : g
Animation > o L ;SQ Te:t.umty 3
) cripts NEW
Audio > . FREE v v BmAudio NEW
Sequencing > [ v # AmbienceEmitter.cs [NEW |
: v # AudioManager.cs [NEW]
> Q ‘
Analysis “‘ o v # AudioManager_Sound.cs {NEW ]
2D > v v ImEditor [New|
Al > . v # AudiolmportPostProcessor.c4iil
" s Search Oculus Integration > + + AudioManagerinspector.cs (i)
v # MinMaxPropertyDrawer.cs Ll
ul > > v # MixerSnapshotProperty Drawiiits
Down Ioad v # OSPPropsPropertyDrawer.cskiil
Im rt v # SoundFXPropertyDrawer.cs Ll
po v # SoundFXRefPropertyDrawer.kiil
v # MinMaxAttribute.cs [NEW]
v # SoundEmitter.cs

All None Cancel  Import



Takes a while to import

* You will see Oculus folder in your

project window.




Rendering Settings

* ref

* Project settings > Player > Other Settings

Player

Other Settings

Rendering
Linear

Auto Graphics API
Graphics APIs

OpenGLES3

Require ES3.1

Require ES3.1+AEP

Require ES3.2
Color Gamut*

sRGB

Multithreaded Rendering*


https://developer.oculus.com/documentation/unity/unity-conf-settings/

Package Manager

« add Oculus XR Plugin

= Package Manager
+ v Packages: In Projectv Sort: Name 4 v

Unity Technologies Oculus XR Plugin

JetBrains Rider Editor Unity Technologies

Oculus XR Plugin : Version 1.11.0 - October 20, 2021

Test Framework

TextMeshPro _ . . .
Provides display and input support for Oculus devices.

Timeline

Registry Unity
Unity Ul
Version Control
Visual Studio Code Editor

Visual Studio Editor




Project Settings

« Edit > Project Settings > XR Plug-in Management

£ Project Settings

XR Plug-in Management

Initialize XR on Startup v

Adaptive Performance XR Plug—in Management
Audio

Editor
Input Manager

Package Manager Initialize XR on Startup v

Physics Plug-in Providers @ Plug-in Providers @
Physics 2D
Player ARCore Magic Leap Zero Iteration
PresgtManager v Oculus v Oculus
Quality
Scene Template Unity Mock HMD Windows Mixed Reality
Script Execution Order Unity Mock HMD
Services

Ads

Analytics Information about configuration, tracking and migration can be found below.

Cloud Build

Cloud Diagnostics
Collaborate
In-App Purchasing
Tags and Layers
TextMesh Pro
Time
Timeline
Version Control
XR Plug-in Management
Oculus



setup Oculus Link



Oculus Link requirement

* Quest can work as a Rift (stationary setup): Using Unity Editor to debug
* VR ready machine: see compatibility
« Cable: USB 3 Cto C/USBAto C (Anker)

« Software: Install OculusSetup, update to the latest version

* Quest: update to the latest version


https://support.oculus.com/444256562873335/
https://www.amazon.com/gp/product/B01MZIPYPY/
https://www.oculus.com/setup/

Enable Oculus Link

¢ Oculus Link




VR selection + roll-a-ball



overview



3D manipulation tasks

selection

Acquiring or identifying a particular
object or subset of objects from the
entire set of objects available.

positioning

Changing the 3D position of an
object. E.g., moving an object
from A to B.

rotation

Changing the orientation of an
object. E.g., what we just did in
the roll-a-ball example.

scaling

Changing the size of an object.
E.g., resize a GUI on a laptop.



What selection techniques are
there in VR?



grasping pointing

simple virtual hand ray-casting




benefits

limitations

grasping

pointing



benefits

limitations

grasping

a direct way to manipulate
full degree of freedom (DoF)

the range is your arm length
lack of tactile feedback

pointing

 select things that are far away
+ fast

 lack of DoF (e.g., depth)

« what if the targets are far
away - small and close to
each other?



application dependent: choose
the interaction that suits your
application best



. . i . e

There s no

= job simulator & g

= \
™ | ‘




for this lab

select with controller

example: we select and manipulate
the board of roll-a-ball using controllers






import the roll-a-ball project



1) export project as .unitypackage
2) import custom package



Export the roll-a-ball project ]
as .unitypacakge oo

Items to Export

¥ v BMminputactions

5 Assets > Export

v 4 mobile-input.inputactions

v v ImMaterials
v @ Blue.mat
ackage
: v @ Green.mat
1 t Assets GameObject Component Window Help v OGround.mat
Select Assets in your o = ‘ Qriupma
. . ; v Player.mat
Project Window ¢ ShowinExplorer ~ QRedmat
Open .
. s v @ Wall.mat
B Project 2 i J Delete Y v~ WmPrefabs
+ v |Q 3\ € | F9 Rename v W@ Canvas.prefab
Copy Path Alt+Ctrl+C v W@ EventSystem.prefab
aw Assets Ooen Seene Additive v W@ Pick-up.prefab
» Bm inputactions v W@ Pickups.prefab
- View in P N T
» Bm Materials View in Package Manager L ;gewnzgs_prefab
» Bm Prefabs Import New Asset... v € roll-a-ball-mobile-acc.unity
» Bm Scenes :ETport::c::ge ’ v € roll-a-ball-mobile-att.unity
; ort Package... ;
> Im Scripts — v v WmScripts
nd References In Scene v # CameraController.cs
;: T(;J(XtMeSh Pro ST v # PlayerController.cs
> ackages v # Rotator.cs
RefreSh Crri+R v #|TiltingGround.cs
Reimport v v ImTextMesh Pro
Reimport All ¥ v ImDocumentation
v %) TextMesh Pro User Guide 2016.pdf
Extract From Prefab v v BEFonts
RRER v LiberationSans - OFL.txt
v AaliberationSans.ttf
Update UlElements Schema v +~ BBResources

Open C# Project

All

¥ v ImFonts & Materials

None ¥ Include dependencies Export...




Export your project as .unitypackage

Downloads v O

~ Name Date modified Type

v Today (3)

roll-a-ball.unitypackage 10/5/2020 14:20 Unity package
%) PseudoHapticWeight_CHI2019.pdf 10/5/2020 16:23 Adobe Acrobz
% 2002.07927.pdf 10/5/2020 16:23 Adobe Acrobsz

e



Import the roll-a-ball

« Assets > Import Package > Custom Package

Assets GameObject Component Oculus Windo n Import package ... X
! Create > 7
| Show in Explorer T ¥ > ThisPC > Downloads v O &) Search Downloads
Open
Delete Organize +  New folder =~ M @
Rename A g : .
| = This PC Name Date modified Type Size
Copy Path Alt+Ctrl+C
Open Scene Additive - 3D Objects v Today (1)
< -a- i : i i 3
View in Package Manager I Desktop . roll-a-ball.unitypackage 10/5/2020 14:20 Unity package file 1,357
Import New Asset._ [=| Documents v Yesterday (1)
Import Package > Custom Package... I ¥ Downloads VRTK Sample.unitypackage 10/4/2020 23:39 Unity package file 10,081
Export Package... J’ Music v Last week (1)
Find References In Scene = _ .
: &=/ Pictures http%3a%2f%2fwww.gtlib.gatech.edu%2f.. 10/3/2020 01:26 File folder
Select Dependencies )
' Quest
Refresh Ctrl+R ‘I v Last month (1)
Reimport & videos helveticaneue 9/21/2020 14:28 File folder
Reimport All L0500
Extract From Prefab ~- DATA (D)
Run APl Updater... A aa ' ML >
]
Update UlElements Schema File name: |roll-a-ball.unitypackage Vv wmypacnayc . \'ypackage) v

Seed XR Input Bindings




Import Unity Package

roll-a-ball

Import !

-
S
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scene



IN your Scene

 Scene = Hierarchy _

N N I DR A E
] — v <) VR selection
1. delete MainCamera 08 a0 amersble
v () Environment
1) Floor
) Table

create a huge floor for VR

) Directional Light

add a Cube as a table

B~ W N

Use an Empty GameOQObiject
(Environment) to collect

non-interactable GOs




Add OVRCameraRig

* Project panel > Assets > Oculus >
VR > Prefabs > OVRCameraRig

* Drag it into your scene

* Inspector > OVRManager >

Tracking > select Floor Level

B} v OVR Manager (Script)

Target Devices

Configure Target Devices in OcL

Performance/Quality
Use Recommended MSAA LI v

Monoscopic

Min Render Scale

Max Render Scale

Head Pose Relative OffsetR X 0
Head Pose Relative Offset T X 0
Profiler Tcp Port 32419

Tracking Origin Type Floor Level

Use Position Tracking v
Use IPD In Position Tracking v
Reset Tracker On Load

Allow Recenter

Late Controller Update

Display
Color Gamut

%= Hierarchy

+v (oAl

v € VR selection
» (1) Environment

¥ OVRCameraRig
v () TrackingSpace
() LeftEyeAnchor
) CenterEyeAnchor
£ RightEyeAnchor
(0 TrackerAnchor
v () LeftHandAnchor
) LeftControllerAnchor
v £ RightHandAnchor
() RightControllerAnchor




Add OVRControllerPrefab

. chy = i | @ Inspector g i
. > > ;
PrOJeCt panel Assets ol ." v LeftOVRControllerPrefab Static v
VR selection* $ - T r YT
1) Environment Tag Untagge v Layer Default M
OCUIUS > VR > Prefabs > ## OVRCameraRig >| Prefab  Open Select Overrides v
v () TrackingSpace :
€0 LeftEyeAnchor v ). Transform 0 3 i
CenterEyeAnchor it
OVRControllerPrefab Sl i Posticn OIS O C
&) TrackerAnchor Rotation X0 YO Z0
. . ¥ () LeftHandAnchor Scale X 1 Y 1 &1
ot LeftControllerAnch
Drag it as a Child of e TR
v RightHandAnchor Script OVRControllerHelper
|eftControllerAnchor ¥ (9 RightControllerAnchor Model Oculus Touch & OculusTouchForQuestAndRift ®
» W% RightOVRControllerPrefab > _
Model Oculus Touch @ OculusTouchForQuestAndRift ®
Model Oculus Touch @ OculusTouchForRiftLeftModel ®
« Select L Touch Model Oculus Touch & OculusTouchForRiftRightMod: @
Model Oculus Touch @ OculusTouchForQuest2LeftMi ®

« Same for the Right Controller Controller T -




Add OVRControllerPrefab

 If you have Oculus Link, enter
play mode and test the scene.

* Feel free to edit your scene.




add old stuffs from roll-a-ball

« Use an Empty GameObiject (roll-a-ball) to collect

Player Y &9 roll-a-ball
) Player
Ground & Ground
- Walls > &9 Walls

‘ .
Pickups > gy Pickups

* They are at the same ‘Child’ hierarchy.

« Scale down to a size you like (check and edit with Oculus Link)



Ground (roll-a-ball)

» select Convex in Mesh Collider

Tag Untagged  ~ Layer Roll-a-ball +
ﬁ\ n orm -

v

None (Physic Material) ®
EPlane O]




Ul text

@ inspector | A

. v Canvas | Staticv
« GameObject > Ul > Text — TextMeshPro @, T oG .
v :%  Rect Transform @  :

 Add two TMP, one for Count, one for Win.

Pos X PosY _ Pos Z

: 0 128 66
 In the inspector of Canvas > Render Mode > Width  Height
500 500 | il R
> Anchors
Pivot X05 YOS5
 The Text would be like a 3D object in the scene. Rotation Xo Yo [Zo
Scale X 0.2 Y 0.2 Z 0.2
mmnml:n v 8 v Canvas @ =
= v Render Mode World Space -
Event Camera None (Camera) ®

Event Camera may not register Ul events

' A World Space Canvas with no specified
correctly.

Sorting Layer Default v
Orderin Layer 0 |
Additional Shader Ch Mixed... v




Ul text

« Remember to set reference back to our PlayerController script of roll-a-ball.

-

¥ # v Player Controller RAB (Scrip ® 3 :

Script PlayerControllerRAE
Speed 20
Count Text 'T|Count (TextMeshP| ®

Win Text Object ) Win ®



interaction



if (
if (not selected and
selects roll-a-ball
else if (selected and
releases roll-a-ball



Use IndexTrigger as input

Left Controller Right Controller

Axis2D.PrimaryThumbstick
Button.PrimaryThumbstick (left stick press)

Axis2D.SecondaryThumbstick
Button.SecondaryThumbstick (right stick press)

! /
&) —— Button.Two

Button.One

Button.Four —___

Button.Three

Button.Start Reserved

N
((\ %m D.PrimaryIndexTrigger /

Axis1D.SecondarylndexTrigger

4

Axis1D.PrimaryHandTrigger Axis1D.SecondaryHandTrigger

Refs L7


https://developer.oculus.com/documentation/unity/unity-ovrinput/

Let's have a look in our game

« Unity Colliders

static
(Wall)

coder detect collision:
Add dynamic « OnCollisionEnter()
Rigidbody | (Player, « OnTriggerEnter()
Pick-up) detect when one collider enters

the space of another without
creating a collision

In this example:
Controller has OnTriggerEnter
Roll-a-ball is triggered


https://docs.unity3d.com/Manual/CollidersOverview.html

Roll-a-ball > add Box Collider

+ Use Edit Collider to modify the | 2"
JJ ~ Static

boundary to fit the size of Ground. | T Unessed = '

Transform

None (Physic Material) ®
0.09232701Y 0  Z -0.0461647

22.04113 2.189852 21.95558
Add Component




One problem about Colliders

which collider does the have their
controller trigger? own colliders



Layer

« We create different layers so that

the colliders of roll-a-ball and

colliders of selection won’t affect

each other.




Add Layer

| Stati
aC selection
0: Default
1: TransparentFX
2: Ignore Raycast
4: Water
5: Ul
8: roll-a-ball

. 9: selection

create two

layers
||

ey




roll-a-ball layer

Staltlc

° Player Lave oll-a-ball ~
Prefak — Prefab Open | Sele

* Pickups |

« Walls

« Ground

Change Layer
Roll-a-ball ~
. Do you want to set layer to Roll-a-ball for all child Drefah Select ovemnues — —
63 objects as well? - Transform
Transform s -

[ Yes, change children ] No, this object only Cancel




selection layer

« Empty GameOQObiject roll-a-ball

Change Layer

-0.12713C
2.53908

Do you want to set layer to Roll-a-ball for all child
Q objects as well?

No, this object only

Yes, change children [

] cocn




selection layer

LeftHandAnchor
* RightHandAnchor
Add Collider

isTrigger

Adjust collider size

v € VR selection

) LeftHandAnchor

Change Layer

Do you want to set layer to Roll-a-ball for all child
@ objects as well?

Yes, change children [

No, this object only

] cocn




Edit > Project Settings > Physics > layer collision matrix

£ Project Settings

Audio Physics
Editor ¥ Layer Collision Matrix
Graphics
Input Manager g o
F
Physics 2D @ 3= ;’,g
Player 2e =238 -« roll-a-ball objects have
Preset Manager = . % g = EC? . o
Ll 2SS e physics within roll-a-
Script Execution Order Defaultviviviviviviv _
Tags and Layers TransparentFX v v v v v v ball ObjeCtS.
v TextMesh Pro lanore Raycast v v v v v . . ,
Settings Water v | v | | v  selection objects won't
i v v v .
e roll-a-ball |~ trigger roll-a-ball
XR Plugin Management seiecuon v

Cloth Inter-Collision



Add Rigidbody on

LeftHandAnchor RightHandAnchor

Roll-a-ball

LeftHandAnchor Static RightHand Anchor




Add a new script ‘MySelect.cs’ on

LeftHandAnchor RightHandAnchor

ag Untagged v

LeftHandAnchor

ag Untagged v (O
Transform



In MySelect.cs

0 references

¢ DeteCting Whether VO1C OnTr;igger‘Enter‘(Collider other)

it (other.gameObject.name == "roll-a-ball")
{

isInCollider = true;
selectedObj = other.gameObject;

0 references

id OnTriggerExit(Collider other)

if (other.gameObject.name == "roll-a-ball")
{

isInCollider =
selectedObj = null




if (
if (not selected and
selects roll-a-ball
else if (selected and
releases roll-a-ball



Use IndexTrigger as input

Left Controller Right Controller

Axis2D.PrimaryThumbstick
Button.PrimaryThumbstick (left stick press)

Axis2D.SecondaryThumbstick
Button.SecondaryThumbstick (right stick press)

! /
&) —— Button.Two

Button.One

Button.Four —___

Button.Three

Button.Start Reserved

N
((\ %m D.PrimaryIndexTrigger /

Axis1D.SecondarylndexTrigger

4

Axis1D.PrimaryHandTrigger Axis1D.SecondaryHandTrigger

Refs L7


https://developer.oculus.com/documentation/unity/unity-ovrinput/

In MySelect.cs

triggerValue = OVRInput.Get(OVRInput.Axisl1D.PrimaryIndexTrigger, controller);

if (isInCollider) access the trigger value
{ from the selected controller

1t (!isSelected && triggerValue > 0.95f)

else 1f (isSelected && triggerValue < 0.951)




select

it (lisSelected && triggerValue > 0.951)
{

1sSelected =

S

selectedObj.transform.parent = this.transform;

make roll-a-ball as the _‘r- i;gijt:ilm;‘:l: felectedObj .GetComponent<Rigidbody>();
Child of HandAnchor ' |

rb.useGravity = e
rb.velocity = Vector3.zero;
rb.angularVelocity = Vector3.zero;




release

else if (isSelected && triggerValue < 0.95f)
{

isSelected = false;
selectedObj.transform.parent = null;
Rigidbody rb = selectedObj.GetComponent<Rigidbody>();

rb.useGravity = true;

rb.isKinematic = false;

rb.velocity = OVRInput.GetLocalControllerVelocity(controller);
rb.angularVelocity = OVRInput.GetLocalControllerAngularVelocity(controller);

* remove Parent

« adjust all the physics back

 velocity and angular velocity have to use
the tracked value from OVRInput



variables

references

references

, MySelect : MonoBehaviour

references

OVRInput.Controller controller;

triggerValue;

[SerializeField] priva | 1sInCollider;

[SerializeField] priva | isSelected;

6 references

GameObject selectedObj;



Select L & R Touch in the inspector

LeftHandAnchor

RightHandAnchor

LeftHandAnchor 7 Stati BT .
ag Untagged v L B Untagged _
) l ransiorm —_ — - : —




code 1/3

: MonoBehaviour

eferences

OVRInput.Controller controller;

erences
triggerValue;

3 references

[SerializeField] priva | isInCollider;

4 references

[SerializeField] priva | isSelected;

6 references

GameObject selectedObj;

triggerValue = OVRInput.Get(OVRInput.AxislD.PrimaryIndexTrigger, controller);



J ITITICIHILTO

id Update()

code 2/3

triggerValue = OVRInput.Get(OVRInput.Axis1D.PrimaryIndexTrigger, controller);

if (isInCollider)
{

if (!isSelected && triggerValue > 0.95f)
{
isSelected = true;
selectedObj.transform.parent = is.transform;
Rigidbody rb = selectedObj.GetComponent<Rigidbody>();
rb.isKinematic = true;
rb.useGravity = false;
rb.velocity = Vector3.zero;
rb.angularVelocity = Vector3.zero;

-

else if (isSelected && triggerValue < 0.95f)
{
isSelected = false;
selectedObj.transform.parent = null;
Rigidbody rb = selectedObj.GetComponent<Rigidbody>();
rb.useGravity = true;
rb.isKinematic = false;
rb.velocity = OVRInput.GetlLocalControllerVelocity(controller);
rb.angularVelocity = OVRInput.GetlLocalControllerAngularVelocity(controller);

-
-




code 3/3

references

OnTriggerEnter(Collider other)

if (other.gameObject.name == "roll-a-ball")
{

isInCollider = true;

selectedObj = other.gameObject;

0 references

OnTriggerExit(Collider other)

if (other.gameObject.name == "roll-a-ball")
{

isInCollider =
selectedObj =




deploy



File > Build Setting > Build And Run

It takes a while to
build project

Scenes In Build

Samples/Farm/Scenes/ExampleScene
v Scenes/roll-a-ball-VR

Platform

;] PC, Mac & Linux Standalone

-3
|'| Android

-- . .
0o Universal Windows Platform

I'\zOS tvOS
=ra PS4

iOS ios

-

!‘\ Xbox One

WebGL

Player Settings...

|ii| Android

Texture Compression

ETC2 fallback
Export Project
Symlink Sources

Add Open Scenes

(ASTC v |
32-bit v

Build App Bundle (Google Play

Create symbols.zip
Run Device
Development Build
Autoconnect Profiler
Deep Profiling

Script Debugging
Scripts Only Build
Compression Method

Default device v  Refresh

Patch Patch And Run
LZ4 v

Learn about Unity Cloud Build

Build Build And Run




File > Build Setting > Build

It takes a while to
build project

Add Open Scenes

g PC, Mac & Linux Standalone

= L
|'| Android

l‘ Universal Windows Platform

Default device v

@ Xbox One

Player Settings... m Build And Run



SideQuest (link to download)

&« C @ © & https;/sidequestvr.com/setup-howto B - 9% n ¢ B =
< Google 247E= The New York Times - ... @ MIT Technology Review @ wenjietseng (wjtseng9... Deepl Translator My Library | Zotero 29 Google Calendar (3 research [ PhD at Telecom Paris [ Interesting ] Unity/Graphics £33 cv/mL/DL »
% SlDEQUEST ( ¥ GET SIDEQUEST ) (ql':- PROMOTE ) search games... SIGN IN
Download & Setup SideQuest
Step 1: Download/Update SideQuest & Sign How To Video: Cas and Chary VR
U P @ OCULUS QUEST - How. To,Sideload Using Sid... o »
Install SideQuest on windows, linux or mac and sign up for an account . > : Watch later ~ Share

Vﬁ‘%
Windows Download (DOWNLOAD FOR WINDOWS 10 X64) '
53.82MB / 25,628 downloads
macOS Download (' DOWNLOAD FOR 0S X / MACOS 10.12+ ) ,
b.n
72.77MB / 4772 downloads ; - >

__
rere Bl e ( DOWNLOAD FOR LINUX ) I nlA, TQI I c : ‘


https://sidequestvr.com/setup-howto

SideQuest also has other tools!

v0.10.11 Oculus Quest > Not found... f§ 100%

&% SIDEQUEST : : run ADB

- streaming commands
I.ET'S organize [} organize

GO oo files § applications

CHOPPING'

Let's Go ChopplngI EARLY AC

pppppppppppppppppppppppppppppppppppppppppppppppppppppppppppppp
experience!



SideQuest > upload apk

press this icon
shows connected to install

ith the devi
WI e aevice =S, NS 8§ [ X

v0.10.11 Oculus Quest > Not found... f§ 100%

Install APK file from folder on computer. SIGN IN



Open
T ¥ > ThisPC > Downloads v O L Search Downloads
Organize ~ New folder = v [N o
@ 2020 UIST virtual * Name Date modified Type Size
Scripts v Today (4)
& slides & rool-a-ball-VR.apk 10/5/2020 23:26 BlueStacks Androi.. 46,1
VAR2020-mobile 4] PseudoHapticWeight_CHI2019.pdf 10/5/2020 16:23 Adobe Acrobat D.. 6,6
0?,3 Dropbox [ﬁ 2002.07927.pdf 10/5/2020 16:23 Adobe Acrobat D... 8
roll-a-ball.unitypackage 10/5/2020 14:20 Unity package file 1,3
@ OneDri
newrive v Yesterday (2)
@ This PC &T manifestjson 10/4/2020 23:39 JSON File
P 3D Objects VRTK Sample.unitypackage 10/4/2020 23:39 Unity package file 10,0
I Desktop v Last week (14)
Documents setup.log 10/3/2020 01:22 Text Document
,_ﬁ -t con oo £..00 LA ialalalaWat el Lt 0L L L S
¥ Downloads | >
File name: rool-a-ball-VR.apk ’AII FLESEE v
Open Cancel

~



Where Is the apk on

the Quest?

Apps (the grid icon)
top-right tab
unknown sources
scroll down and find
your project (or select

most recent)




Expected outcome

« Set up your Quest 2
« Adapt your minimal roll-a-ball game into a VR version
» Play around with your Quest and Oculus Integration API (e.g.,

controllers)
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Questions?



Pick up your Meta Quest

31.10 Tue. 14-16h
01.11 Wed. 9-12h, 13-16h
02.11 Thur. 9-12h, 13-16h

Come to A307, S2|02, to pick up your Quest 2!
If you could not make it, please contact

wen-jie.tseng@tu-darmstadt.de or
willich@tk.tu-darmstadt.de



mailto:wen-jie.tseng@tu-darmstadt.de
mailto:willich@tk.tu-darmstadt.de

